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TOPIC ---------------------------------------------------------

The following article is the Read Me document for the PANTONE Calibrated Support
files for the Color LaserWriter 12/600 PS printer.

DISCUSSION ----------------------------------------------------

Overview
========
The PANTONE support files enable you to load the PANTONE color table calibrated
for your Apple Color LaserWriter 12/600 PS printer as a usable color palette in
the most popular Pantone-licensed desktop publishing programs.

Custom CMYK combinations for almost every color in the PANTONE MATCHING SYSTEM
can be selected. The only exceptions are specialty colors such as metallics,
fluorescents and double impressions. For best results, be sure to use papers
recommended in the printer manual.

Note: The tables and palette files provided for the Apple Color LaserWriter
12/600 PS printer are calibrated only for this printer.  If you plan to create
color separations, you must re-color the graphics using the built-in PANTONE
color tables supplied by the PANTONE-licensed application.

Installation on a Macintosh
===========================
Follow the instructions below to install the files in the PANTONE Color Charts
folder. For the files in the Application Support folder, see the installation
instructions for each application provided in this document in the Application
Support section.

Installing and Printing the Color Charts on a Macintosh
-------------------------------------------------------
Installing the Color Charts requires about 1.7 megabytes of hard disk space. To
install the Color Charts, first open the PANTONE Color Charts folder. Then,
double-click on the ColorCharts.sea file. Press Continue. The self-extracting
archive application asks you for the volume and folder name that you want to
use. By default the application uses the current hard disk and the folder
"ColorCharts Folder". When you've selected the hard disk and the name you want
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to use, press the Save button. The files are decompressed. When finished the
self-extracting archive application  displays the message "Installation was
successful!". Press Quit.

Printing the Color Charts on a Macintosh
----------------------------------------
Four versions of the Color Chart are available:
• PostScript file
• Adobe Acrobat file
• Encapsulated PostScript files
• TIFF files

You use the color chart for the Apple Color LaserWriter 12/600 PS to select the
PANTONE colors that you want to use. To use the color chart, you first print it
on the Apple Color LaserWriter 12/600 PS. Be sure to allow enough time to print
the chart; it takes about forty-five minutes to print the complete chart.

Printing the PostScript Version of the Color Chart
--------------------------------------------------
 Follow these steps to print the PostScript version of the Color Chart:

1. To print the PostScript version of the Color Chart, you use the Apple Printer
Utility that came with your Apple Color LaserWriter 12/600 PS. Double-click the
Apple Printer Utility icon located in the Apple LaserWriter Software folder to
open it.
2. In the dialog box that appears, select the Apple Color LaserWriter 12/600 PS
on which you want to print the color chart and press Open Printer.
3. Choose Send PostScript File from the utility's File menu.
4. In the dialog box that appears, select the color chart file, Clr LW
12/600.ps, located in the Raw PostScript folder.
5. Click Add
6. Click Send. The chart is printed on the selected printer.

Printing the Adobe Acrobat Version of the Color Chart
-----------------------------------------------------
If you have Adobe Acrobat Reader, you can use it to print all or part of the
color chart for the Apple Color LaserWriter 12/600 PS. Make sure that you have
selected the desired Apple Color LaserWriter 12/600 PS printer in the Chooser
first. Next, double-click the Apple Color LaserWriter.pdf file in the Adobe
Acrobat folder in the ColorChart Folder. Adobe Acrobat Exchange opens the color
chart. With this chart, you can print all PANTONE Colors calibrated for your
printer (or print a range of pages if you don’t need them all). It takes
approximately forty-five minutes to print all pages.

Printing the Encapsulated PostScript Version of the Color Chart
---------------------------------------------------------------
If you have an application that uses encapsulated PostScript, you can use it to
print the Color Chart for the Apple Color LaserWriter 12/600 PS. Make sure that
you have selected the desired Apple Color LaserWriter 12/600 PS printer in the
Chooser first. Double-click on your application and then Open the desired file
in the 11x17 Charts as EPSF folder. The suffix of each file corresponds to the
range of PANTONE colors contained in the file.



Printing the TIFF Version of the Color Chart
--------------------------------------------
If you have an application that can read TIFF files, such as Adobe Photoshop
3.0, you can use it to print the TIFF version of the Color Chart for the Apple
Color LaserWriter 12/600 PS. Make sure that you have selected the desired Apple
Color LaserWriter 12/600 PS printer in the Chooser first. Run your application
and then Open the desired file in the Tiff folder within the ColorCharts Folder.
You may need to reduce the size of the image before printing to the Apple Color
LaserWriter 12/600 PS.

The files are named with the pages where you can find the PANTONE colors in the
PANTONE Process Color Imaging Guide.  For example, a file named "1-11.tif"
includes PANTONE colors which appear on pages 1 through 11 in the PANTONE
Process Color Imaging Guide. This book is a fan guide, displaying side-by-side
color squares: one square being the solid PANTONE Color and another representing
the way that color prints as a process (CMYK) color. The PANTONE Process Color
Imaging Guide does not come with the PANTONE® Calibrated support files; it is
purchased separately.

Note:  These TIFF files can be used in any image processing software that
supports CMYK TIFF and CMYK image editions.

Caution:  Do not convert these images to RGB. If you do, the colors will not
print properly.

Extras
======
Two additional files are included on the PANTONE disk. First, the file labeled
Clr LW 12/600.lut is an Excel spreadsheet containing each PANTONE color's cmyk
values. You can optionally use this as an aid in creating cmyk separations. The
second file, contained within the PANTONE ColorDrive Support folder, is a color
palette for the Color LaserWriter 12/600 PS for PANTONE's ColorDrive application
available separately from PANTONE.

Application Support
===================
This section explains how to load calibrated palettes for the Apple Color
LaserWriter 12/600 PS printer into Pantone-licensed applications.These
instructions assume you are thoroughly familiar with the correct operation and
usage of the given software application.

Adobe Illustrator
-----------------
The PANTONE® Calibrated support files include a color file that is similar to
the standard PANTONE Colors file included with Illustrator, except that the CMYK
values are calibrated for the Apple Color LaserWriter 12/600 PS printer. This
file, Clr LW 12/600.ai, is located within the Illustrator folder within the
Adobe folder  located in the Application Support folder.

To use the file follow these instructins. Open Illustrator 5.0, and then, use
Open from the File menu to open the Clr LW 12/600.ai file. Once the file is
loaded, select the Show Paint Style item from the Windows menu.The Paint Style
floating window appears. Click the solid color button. The named color list then



appears in the scrolling window. Scroll down until you see the PANTONE Colors
appear with a “CH” suffix. This suffix distinguishes these colors from the
default PANTONE Colors in Illustrator which have a “CV” suffix.  You may now
apply these colors to your document.

In older versions of Adobe Illustrator, you may select the calibrated PANTONE
Colors through the Paint Style and Custom Color dialog boxes.

Adobe Photoshop 3.0
-------------------
You can use the TIFF version of the Apple Color LaserWriter 12/600 color chart
to select PANTONE colors within Photoshop. The TIFF version of the color chart
is a set of files located in the Tiff folder within the ColorCharts Folder. Open
the desired TIFF file from Photoshop's File menu and use the Eyedropper tool to
select each PANTONE color.

Alternatively, you can use the Clr LW 12/600.aco swatch file from within
Photoshop to select the desired PANTONE color.

First, move the Clr LW 12/600.aco file to the Color Palettes folder in the
Goodies folder in the Photoshop folder. Next, open Photoshop. To use the swatch
file, select Palettes from the Window menu; then, select Show Swatches. The
swatches dialog appears. Press the arrow on the right to display the available
swatch files. Select the Clr LW 12/600. Use the Eyedropper tool to select the
desired PANTONE color.

Aldus FreeHand 3.1
------------------
For users of FreeHand 3.1, PANTONE color support provides a calibrated PANTONE
Color Palette in the form of a loadable color library.  Select the Colors menu
item from the View Windows menu.

The Colors window appears. Click the arrow on the right-hand side of the Colors
window and select "Import." Find and open the file "Apple Color Laser.clib".
Select the PANTONE Colors from the scrolling list. (To select multiple colors,
hold down the shift key.) The calibrated PANTONE colors you selected now appear
in the Colors window.  You may now apply them to your document.

Macromedia FreeHand 4.0/5.0
---------------------------
These instructions apply to both Freehand 4.0 and 5.0. Move the file named Apple
Color Laser.ACF in the FreeHand folder to the Color Folder in the Aldus Folder
inside the System Folder.

Open FreeHand. Create a new FreeHand document. Select Color List from the Window
menu.The Color list window appears. Pull down under Options and then select the
Apple Color Laser palette. The library of colors for the Apple Color LaserWriter
12/600 PS appears. Choose a desired PANTONE color and click OK.

You can use the Color Mixer item within FreeHand to identify the CMYK values for
a particular PANTONE color. Choose Color Mixer from the Window menu. The Color
Mixer window appears. Drag the desired PANTONE color from the library of colors
for the Apple Color LaserWriter 12/600 PS into the Color Mixer box, and the CMYK



values for that particular color will appear.

Aldus PageMaker 5.0
-------------------
PageMaker uses the same color file as FreeHand 4.0 and 5.0.

Move the file named Clr LW 12/600.BCF in the Pagemaker folder to the Color
Folder in the Aldus Folder inside the System Folder.

Open PageMaker 5.0. Select the Define Colors item from the Element Menu. On the
Define Colors dialog box click the New... button. In the Edit Color dialog box
that appears click on the Libraries: arrow button and select the Apple Color
Laser item that appears in the hierarchical list. The library of colors for the
Apple Color LaserWriter 12/600 PS appears. Holding down the shift key, click on
the PANTONE colors you want to add to your working colors palette and click OK.
The colors you selected will now appear in your Define colors list. You can now
use these in your PageMaker documents.

Canvas
------
PANTONE color support provides a special palette for Canvas named Clr LW
12/600.Canvas.

To load the palette, in Canvas, choose PANTONE Colors from the Windows menu. The
PANTONE Colors dialog appears. Choose Load... from the Color Sets pop-up menu.
Enter the name of the Apple Color Laser palette. These colors may now be used in
your artwork.

MacDraw Pro
-----------
First, move the Apple Color LW 12/600 file from the floppy's MacDraw Pro folder
to the PANTONE® Palettes folder in the MacDraw Pro folder on your hard disk.

To use the new color palette follow these steps:

1. Open MacDraw Pro or double-click on your MacDraw Pro document.
2. Tear off the Color palettes floating window from the blend icon.
3. Choose Open Palette from the Color palette’s File menu.
4. Then open the MacDrawPro palette provided.

Note:  This palette may work with other Claris products.  Since PANTONE does not
support these products, do not use the Apple Color Laser palette for
separations.

Quark XPress 3.3x
-----------------
As Quark XPress does not support loadable palettes except as part of a document,
PANTONE color support provides Quark XPress 3.3 native files instead. The
maximum number of colors in each Quark document is 200. PANTONE provides a
series of files each containing a range of PANTONE colors.  The file name
contains the PANTONE color range contained in each file.  For example, a file
named PANTONE 100-249 contains PANTONE colors from PANTONE 100 to PANTONE 249.



To use these files, use Open from the Quark Express File menu to open the
desired palette file.

Note:  The PANTONE names in the Quark XPress Apple Color Laser palettes have a
space character in front of PANTONE.  Do not rename these colors without the
space or Quark will re-map its default CMYK color values for PANTONE colors into
your calibrated PANTONE Colors for the Apple Color LaserWriter 12/600 PS.
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